
October 2005

General

Apple Discussions
If you have an Internet connection of 

any kind, you have access to one of the 
most useful help systems around—Apple’s 
Discussion forums. Here you can read 
questions and answers on a wide variety 
of topics, and post your own questions if 
you like.

There are separate discussion forums for 
various kinds of Apple hardware (Macs, 
Airport, iPod, and so on), and also for the 
full range of Apple system and application 
software (iPhoto, iTunes, AppleWorks, 
and the like); and yes, older hardware and 
system software are still covered.

There are two levels of participation in 
these discussions—you can browse existing 
topics freely from the start, but in order 
to post questions of your own, you need 
to register. This is a painless process and 
gives access to some other interesting areas 
of the Apple website as well. To locate 
the discussion area and register to post 
questions, proceed as follows:
•	 Direct your Web browser to the address 

(www.apple.com).
•	 Click the tab labeled “Support.”
•	 In the same general area, click the word 

“Discussions.”
•	 Here you can see a listing of the main 

discussion forums and, by clicking any 
one of them, can read other people’s 
questions and answers. You cannot yet, 
however, post questions of your own. To 
do this:

•	 Look for a small “house” icon in the 
right hand part of the page, and click 
the word “Login” beside it.

•	 After reading some general explanation 
text, click the “Login” button.

•	 Click the “New Account” button and 
follow the instructions to create an 

“Apple ID” and password that you will 
use in future to enter the Discussions 
area (at the fifth bullet point above) as a 
registered user. You will find that after 
the first time, you won’t even need to 
enter your Apple ID and password to do 
this—they will be remembered. Seeking 
help is now quite a simple process:

•	 Go to the Discussions page and Login.
•	 Click the relevant discussion forum title.
•	 Click the link “Post a New Topic” (above 

the topics list, towards the right side of 
the page).

•	 Enter your question, taking care to make 
the Subject line as descriptive as possible. 
Some folk will never read past that line 
unless the gist of your inquiry is clear 
from it. Look at other people’s postings 
for good and bad examples.

•	 You will note at the bottom left of the 
message form a pop-up menu labeled 

“Subscribe to this topic.” Leave this 
menu set to “email,” which means that 
each time someone posts a reply to your 
question, you will be advised by email. 
This saves you from having to check the 
Discussions web page more often than 
necessary.

•	 To post your question, click the “Add 
Topic” button.

Welcome!

These tips have been culled 
from user group newsletters, 
Macintosh-related books, 
magazines, and other sources. 
Thanks to all who have 
contributed and provided this 
valuable information to the 
Macintosh community.

Several hundred new tips are 
added to the Hints & Tips 
Database each month, with 
60–70 of them featured in this 
monthly newsletter.

If you haven’t used the 
searchable Database of tips 
available on this website, I 
urge you to give it a try. For 
$4.95, you can access the entire 
library of tips for a month. 
For $48, you can have access 
for a year. It is a lot easier and 
faster than going through a pile 
of newsletters and magazines 
looking for that tip you read 
about a few months ago.

If you like this newsletter, the 
best way to support it is to 
subscribe to the Database.

— Paul Taylor
paul@mac-hints-tips.com
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•	 The page you then see can be 
confusing. It seems to indicate 
that you need to click yet another 
link to post your question. 
That is not so. Simply click the 
“Discussions” link in the header 
once more, re-enter the relevant 
discussion forum, and you will 
see that your question has indeed 
been posted. If you subsequently 
revisit your posting (by clicking 
its entry in the topic list) you 
will also see any replies that have 
been received. A row of small 
icons above each message enables 
you to reply or take other actions. 
(You can even edit or delete your 
original posting if you like.) If 
you allow your mouse pointer to 
hover over each icon in turn, you 
will see what their functions are.
Note that if a reply is helpful, 

you should click the “+” button, 
which gives a “credit” to its author. 
People who have accumulated many 
such credits are promoted to higher 

“levels,” as indicated below their 
names at the left of each message.

The Apple Discussion forums are 
moderated, which means that you 
will rarely read anything that isn’t 
reasonably polite and constructive—
a welcome change from many of the 

“open” forums you may have used in 
the past. ~Steve Cooper
AUSOM News, Melbourne, Australia

Give Classic More Memory
If you run several Classic 

applications at the same time, you 
may wish to give Classic (not 
the individual application) more 
memory. Go to System Preferences. 
Select “Classic.” Make sure you are 
not in the Memory/Versions tab. 
Now Option/click the “Memory/
Versions” tab. This reveals a new 
button, Adjust Memory, in the 
lower right corner. Click the “Adjust 

Memory” button and a new dialog 
appears allowing you to boost 
Classic memory.

Mouse Droppings, Corvallis OR

Cracking Installer Packages
An application that 

unexpectedly quits as soon as it 
is launched usually has a corrupt 
preference file (or files). So, the first 
thing you should do is find the 
suspect files and toss them into the 
trash. Move any matching files to 
the trash, and then try to launch 
the application again. Hopefully, it 
will start up normally and you’ll be 
back in business. 

On the other hand, the 
application itself could be corrupt. 
CharlesSoft’s Pacifist ($20; www.
charlessoft.com) is a shareware 
utility that allows you to crack 
open installer packages and 
extract applications and other files. 
Download the utility and launch it. 
Now insert the Mac OS X Install 
CD and click “Open Mac OS X 
Install Packages.” You’ll soon see 
a list of available packages. Click 
the caret to expand Contents of 
Essentials.pkg, and then click the 
caret to expand Applications. Once 
you’ve spotted your application, 
highlight it and click “Expand 
To.” Choose a location for the 
application and enter your 
administrator password.
Apple Pickers MUG, Indianapolis, IN

Is That Really Email  
from Microsoft?

Be careful. In recent months, 
hackers have been using fake emails 
saying they’re from Microsoft. 
These emails warn the recipients 
that their computers are at risk by 
some terrible security problem and 
urge them to download a file to fix 
it. Of course, this file is a virus or 

some sort of malicious code, and 
before the unsuspecting recipients 
know it, they’ve been infected.

Microsoft has released a guide 
to verifying if a Microsoft security-
related message is legitimate at 
www.microsoft.com/security/
antivirus/authenticate_mail.asp. If 
you’ve gotten these messages before, 
it’s a good idea to check out this 
guide so you’re better able to judge 
the validity of any email message 
from Microsoft.

TMUG Insider, Pleasanton, CA

Flash Hidden Games
Check out the following in Flash 

MX 2004. Click on the tiny ‘TM’ 
near the number 2004 in the About 
Flash dialog. The About screen will 
load with a choice of six different 
games... loads of fun!

Sterling Ledet

Reduce the Size of the Sidebar
Does the Sidebar sometimes 

occupy too much space in Panther? 
Grab the gray divider bar and drag 
it to the left. You can stop to just 
see the icons without the text, or 
you can drag the divider all the 
way to the left and eliminate the 
Sidebar entirely.

Mouse Droppings, Corvallis OR

Ways to Force Startup from a CD
Holding down the “C” key 

during startup is supposed to force 
your Mac to start up from the CD 
or DVD in its optical drive. Often, 
that doesn’t work, so here are some 
other ways to do it:
•	 During startup, hold down the 

Option key instead. At the 
resulting window, choose your 
CD or DVD as the startup 
volume.

•	 During startup, hold down the 
Shift, Option, Command, and 
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Delete keys. This should force 
your Mac to bypass its hard drive 
and look for any other volume 
with Mac OS on it.

•	 Insert the CD or DVD while Mac 
OS is running, choose Apple 
Menu > System Preferences > 
Start-up Disk and then select 
your CD or DVD and restart 
your Mac.
Be sure to wait for the startup 

chime before using any of these 
key combinations, and to use a CD 
containing a version of Mac OS X 
that is at least as new as the version 
your Mac shipped with—earlier 
versions won’t work.

MacFixIt.com  
via Design Tools Monthly

Scroll-Wheel Mouse?
If you’re a user of a scroll-

wheel equipped mouse, you may 
be happy to learn that you can 
use the wheel to scroll windows 
horizontally simply by holding 
down the Shift key. 

I’ve only tested this trick 
in 10.2.1—it works in many 
applications, although not all—and 
of course it will not function in 
applications that do not already 
support the scroll-wheel.

And also: http://article.gmane.
org/gmane.comp.audio.emagic.
logic.users/165517

If you enter “horizontal scroll” 
into Google you will find quite a lot 
of information about mice that can 
scroll horizontally. Some have five 
buttons! ~Alan Winslow

TMUG Insider, Pleasanton CA

Data Lost?
If all of a sudden your hard drive 

won’t mount, the first step is to 
use your Disk Warrior CD (latest 
version is 3.0.3) for Alsoft (www.
alsoft.com) and have it rebuild the 

directory. If Disk Warrior says that 
the disk is too damaged to rebuild 
the directory, use Data Rescue 
for ProSoft Engineering (www.
prosoftengineering.com) to recover 
whatever data is on the disk. If 
there is something physically wrong 
with the disk, you may be out of 
luck, period. But if there just was a 
software corruption of an otherwise 
ok disk, Data Rescue should be able 
to recover your data.

I suggest having both products 
as part of you basic file utilities. 
Really, they should come with every 
new computer! Use Disk Warrior 
on a regular basis to fix directory 
problems before they grow and 
become a “Data Rescue” problem.

Regarding Data Rescue, you will 
need a separate disk that is larger 
than the amount of data you want 
to recover. There are other details 
you should know before you use 
it. That’s why those who want to 
prevent the agony of losing priceless 
data at a critical hour should buy 
the software now and learn how to 
use it. If you never have to use it, 
think of it as the best and cheapest 
insurance you never had to use!

A. Victor Goodpasture, ProDigital

The Learning Center
If you are not a subscriber 

to .Mac (that is Apple’s “dot-
Mac service) you may not have 
encountered the Learning Center. 
To locate it, direct your Web 
browser to www.mac.com/1/
learningcenter/. It will quickly 
become obvious that there is 
a substantial range of tutorial 
material here—often a lot easier to 
digest than trawling a Help file. 

Make sure to click the main 
headings in the left column to see 
relevant lists of tutorials in the 
column to the right, and watch 

those disclosure triangles!
A good number of the tutorials 

are in movie form, or offer movies 
as supplements to the main text. 
Since that is so, you really need a 
broadband Internet connection to 
use the Learning Center effectively, 
which could be another good reason 
for splashing out on one! 

An important tip is to watch out 
for buttons labeled “Learn More,” 
and to click them all. Otherwise, 
you will see only an overview of 
the topic.

You might wonder why the 
Learning Center is in the .Mac area 
of the Apple site if you don’t need 
to be a Mac subscriber to use it. 
The answer seems to be that if you 
delve deep into some of the tutorials, 
into the “expert tips” area, you 
will be asked for your Mac ID and 
password. The bulk of the content, 
though, appears to be accessible to 
non-subscribers.

At the moment, the main 
Learning Center subject areas are 
Mac, Mac OS X Panther, iLife 
‘05, iPod, Keynote and iLife ‘04. 
If you use any of these products 
(remembering that iLife includes 
iPhoto, iMovie, iTunes and iDVD), 
a visit to the Learning Center could 
prove very worthwhile.  
~Steve Cooper
AUSOM News, Melbourne, Australia

Improve Security by Storing Your 
Keychain on a USB Flash Drive

If you like the convenience that 
Apple’s Keychain scheme provides, 
but want to add a little more 
security to the mix, get a USB flash 
drive and store your keychain on it. 
That way, your keychain will only be 
accessible when you physically insert 
the drive into the USB port.

To move an existing keychain 
to a flash drive, insert the drive, 
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and then navigate to ~/Library/
Keychains. Locate the keychain you 
want to move and then just drag it 
onto the flash drive. Then, delete the 
original from the Keychains folder.

To enable the newly copied 
keychain, open Keychain Access 
(found at Applications/Utilities/), 
and choose File > Add Keychain. 
Then, navigate to the keychain on 
your flash drive and click “Open.” 
From that point on, whenever an 
application requests a password 
stored in the keychain, you’ll need 
to have the USB flash drive inserted. 
Otherwise, the automatic password 
entry won’t work.

TMUG Insider, Pleasanton, CA

Mac OS X

Recovering from a Freeze
What to do when your Mac stops 

dead—it is not such a big deal.
There are few things more 

alarming to a beginner than a Mac 
that stops dead and doesn’t respond 
to either mouse or keyboard. 
Happily, such events are rarely 
as serious as they may seem, and 
recovery is usually undramatic if 
you follow a simple procedure.

There are significant differences 
between Mac OS 9 and Mac OS 
X in this situation, so they are 
covered separately in this article. 
The Mac OS X situation is much 
simpler and is treated first. If you 
are using Mac OS 9 (or earlier), 
skip the next few sections and look 
for the “Mac OS 9” heading.

In fact, if you read the whole of 
this article, you will observe that 
a freeze in Mac OS X is much less 
disruptive than it is in Mac OS 9, 
and much easier to recover from. 
This is in fact one of the nicest 
features of Mac OS X, together with 

the fact that you will experience 
such events much less often in the 
first place.

Mac OS X
What is a freeze? (OS X)
We say that that a program 

freezes when it no longer responds 
to mouse or keyboard input, and 
shows no other sign of activity. You 
will find that you can work with 
other programs on the Mac, but 
every time you move the arrow 
cursor over the window of the 
frozen program, it turns to the 
spinning rainbow ball and you 
can’t generate any further activity 
in that program.

It is quite possible to postpone 
fixing the freeze; for instance, if it 
is your Web browser that is frozen, 
you can continue to use your email 
program or any others you might 
need, without needing to attend to 
the Web browser. Sooner or later 
though, you will have to attend to 
the frozen program.

Forcing a quit (OS X)
Force the frozen program to quit 

by holding down the Command 
and Option keys together, and 
while holding them, briefly pressing 
the Escape key. (The Command 
key is the one with the cloverleaf, 
to the left of the space bar, while 
the Escape key is at top left of your 
keyboard, usually marked “esc.”) 
Alternatively, you can select “Force 
Quit” from the Apple menu.

Either way, you will see a 
window listing all of the programs 
currently running, including the 
Finder. Click the name of the one 
that seems to be frozen (even the 
Finder if appropriate), then click 

“Force Quit.” The selected program 
will quit and everything else will 
continue to work normally. You can 
then simply relaunch the problem 
program, which will function 

as usual. (If the Finder was the 
problem, it will have relaunched 
automatically.) There is no need to 
restart the Mac.

Logging out/in (OS X)
If you continue to see problems 

(e.g. the offending program freezes 
again), you should log out and log 
back in again. To do this, close 
any open programs, then from 
the Apple menu choose “Log 
Out.” The display will clear to a 
plain background, then after a 
short time you will see the “Log 
In” screen with your name. Click 
the accompanying picture and 
enter your password in the box that 
appears. Click the “Log In” button 
to continue.

Restarting (OS X)
On the odd occasion, you may 

find that you are unable to force 
quit the problem program, and/or 
are unable to log out or restart using 
the Apple menu. If that happens, it 
is time to force a restart.

Most Macs running OS X will 
have been made in the past couple of 
years. On these machines you need 
to press the start button for about 
six seconds, upon which the Mac 
will shut down. Release the button, 
then press it again briefly to restart 
the Mac. If pressing the start button 
for six seconds doesn’t shut down 
your Mac, you will need to try one 
of the methods outlined in the Mac 
OS 9 section for older Macs (see the 

“Forcing a restart” heading).
Mac OS 9 
What is a freeze? (OS 9)
We say that that a program 

freezes when it no longer responds 
to mouse or keyboard input, and 
shows no other sign of activity. You 
will find that you won’t be able to 
do anything useful with the rest of 
the Mac either, until you’ve resolved 
the freeze.
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A freeze is not usually caused by 
any mechanical defect, but rather 
by a software glitch. While it is 
possible just to turn the Mac off 
at the wall switch and then back 
on again, there are better methods 
which may save you from losing 
work in progress, and are certainly 
kinder to your Mac’s electronics and 
hard disk.

Forcing a quit (OS 9)
Quite often, all that has 

happened when you observe 
a freeze is that the application 
(program) you were working with 
has tripped up internally. With a 
bit of luck, all other programs and 
processes are still working, and 
if you could just get the frozen 
program out of the way, you’d be 
able to continue working.

Attempt to force the frozen 
program to quit by holding down 
the Command and Option keys 
together, and while holding them, 
briefly pressing the Escape key. (The 
Command key is the one with the 
cloverleaf, to the left of the space 
bar, while the Escape key is at 
top left of your keyboard, usually 
marked “esc.”)

You will see a dialog that includes 
a “Force Quit” button. If you are 
lucky, clicking this may result in 
the program’s quitting, enabling a 
return to normal operation of the 
Mac. If this happens, you should 
save any work still open in other 
programs, then restart the Mac 
normally. (Although you can skip 
this “restart” step, it will ensure 
that any residual problem has been 
cleared.) Quite often, though, the 
program will not quit and you have 
no option but to force a restart.

Forcing a restart
When you force a restart, the 

Mac’s screen goes black, you hear 
the startup chime, and the Mac 

starts normally. The technique for 
forcing a restart varies from Mac to 
Mac, so read on until you find the 
one that suits yours. (Your Mac’s 
manual may also be helpful.)

Until a couple of years ago, the 
standard way of forcing a restart 
was to hold down the Command 
and Control keys together, then 
press the power button (i.e. the 

“start” button on or near the 
keyboard). If your Mac has such a 
button, try this method first.

Some desktop Macs of this 
vintage also have a restart button on 
the front of the main box, marked 
with a small triangle icon.

If you have an iMac (not a flat 
screen model), you have a special 
restart button. To find it, look in 
the recess on the side of the iMac 
where all the cords plug in. If you 
see two small white buttons towards 
the lower edge of the recess, and 
if the forward button is marked 
with a little black triangle, that is 
the restart button. If your iMac 
has the kind of CD drawer that 
slides out towards you and has an 

“eject” button on it, you will have 
to look further. Within the iMac’s 
side recessed area, and towards the 
back of it, you will see two small 
holes one above the other and about 
15mm apart. You need to poke 
something slim (a straightened 
paper clip is the standard tool) 
gently into the upper hole until you 
feel a resistance. A further gentle 
push will activate the restart switch.

Most PowerBooks and iBooks 
also have a special restart button, 
either on the back edge amongst 
the various plugs, or above the 
start button on the keyboard panel, 
tucked into the grille below the 
screen. In any case the button is 
marked with a tiny triangle icon.

If your Mac was made within 

the past couple of years, you won’t 
find a restart button of any kind. 
What you are meant to do in this 
case is press the power button and 
keep it pressed for about six seconds, 
when the Mac will shut down. Then 
release the button and press it again 
briefly to restart the Mac.

Practice!
As long as you have no unsaved 

documents, you can do no harm by 
practicing these techniques. In fact, 
I recommend that you do.  
~Steve Cooper
AUSOM News, Melbourne, Australia

Using Disk Utility and FSCK File 
System Maintenance in OS X

When the computer cannot start 
up normally, you may need to use 
a disk repair utility. Mac OS X 
includes two utilities for this: Disk 
Utility and fsck. 

Tip: For Mac OS X 10.4 Tiger or 
later, you should use Disk Utility.

In some situations, file system 
errors may prevent the computer 
from starting up to a normal state. 
This could occur after improper 
shutdown, forced restart, or power 
interruption. These symptoms 
indicate you should use a disk repair 
utility:
•	 Partial start with command line

The computer starts up partially 
then pauses in a command-line 
(text only) environment. A message 
such as “file system dirty, run 
fsck,” may appear. Below the 
message, there is a command line, 
indicated by a number sign prompt 
(#). Commands you type in this 
environment appear next to the 
prompt. When this happens, run 
fsck from the command line.
•	 System starts up partially but 

does not display a command-line 
prompt
The computer may start up but 
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fail to reach the login screen, or it 
may reach the login screen but fail 
to reach the Desktop after you log 
in. In this case, you must start up in 
single-user mode.

Try a Safe Boot
Mac OS X 10.2 can Safe Boot. 

If you have not yet upgraded to 
10.2, 10.3 or later, then skip to the 
next section. A Safe Boot may allow 
you to restart successfully using a 
reduced version of system software. 
In Safe Mode, an automatic disk 
check and repair may resolve your 
issue. Follow these steps:

1. Start up in safe mode. 
2. After the system is fully 

started up, restart again normally.
Safe Boot is a special way to 

start Mac OS X 10.2 or later when 
troubleshooting. Safe Mode is the 
state Mac OS X is in after a Safe 
Boot. Starting up into Safe Mode 
does three things to simplify the 
startup and operation of your 
computer:
•	 It forces a directory check of the 

startup volume. 
•	 It loads only required kernel 

extensions (some of the items in 
/System/Library/Extensions).

•	 It runs only Apple-installed 
startup items (some of the items 
in /Library/StartupItems and 
/System/Library/StartupItems, 
and are different than login 
items). 

•	 Mac OS X 10.4 Tiger only: It 
disables all fonts other than those 
in /System/Library/Fonts. 

•	 Mac OS X 10.4 Tiger only: It 
moves to the Trash all font 
caches normally stored in 
/Library/Caches/com.apple.
ATS/(uid)/, where (uid) is a user 
ID number such as 501. 

•	 Mac OS X 10.4 Tiger only: It 
disables any Login Items.
Taken together, these changes 

can work around issues caused by 
software or directory damage on 
the startup volume.

Safe Mode can be useful for 
troubleshooting. However, certain 
Mac OS X features do not work 
when you are started up in Safe 
Mode. For example, you can’t use 
DVD Player, capture video in 
iMovie, use an AirPort card, use 
some audio input or output devices, 
or use an internal or external USB 
modem.

To start up into Safe Mode (to 
“Safe Boot”), do this:
	 1.	Be sure the computer is shut 

down. 
	 2.	Press the power button. 
	3 .	Immediately after you hear the 

startup tone, press and hold 
the Shift key. Tip: The Shift 
key should be held as soon as 
possible after the startup tone 
but not before. 

	 4.	Release the Shift key when you 
see the gray Apple and progress 
indicator (looks like a spinning 
gear).

During the startup, you will 
see “Safe Boot” on the Mac OS X 
startup screen. To leave Safe Mode, 
restart the computer normally, 
without holding any keys during 
startup.

A Safe Boot for Mac OS X takes 
longer than a normal startup. This 
delay will occur when you see the 
progress indicator (looks like a 
spinning gear). It can be quite long 
(several minutes) depending on how 
long it takes to check and repair the 
directory (if needed). This delay is 
normal for a Safe Boot and caused 
by two of the things that happen 
during a Safe Boot:
•	 Safe Boot forces a directory 

check of the hard drive. This is 
identical to using Disk Utility’s 
Repair Disk or the fsck -fy 

terminal command. 
•	 The cache of kernel extensions 

used to speed startup is ignored. 
(The cache file is /System/
Library/Extensions.kextcache)
Note: Safe Boot is not a feature 

of Mac OS X 10.0 to 10.1.5.
If the computer successfully 

restarts, you do not need to do any 
more troubleshooting. If the issue 
persists, go to the next section.

Try Disk Utility
In most circumstances, you 

check and repair the disk using the 
Disk Utility application included 
with Mac OS X.

1. Insert your Mac OS X CD-
ROM disc or Restore DVD disc, 
then restart the computer while 
holding the “C” key.

2. Once started up from CD or 
DVD, choose “Disk Utility” from 
the Installer menu. Important: Do 
NOT click “Continue” in the first 
screen of the Installer. If you do, 
you must restart from disc to access 
Disk Utility.

3. Click the First Aid tab.
4. Click the disclosure triangle 

to the left of the hard drive icon to 
display the names of your hard disk 
volumes and partitions.

5. Select your Mac OS X volume, 
if necessary.

6. Click Repair.
Disk Utility checks the disk. If 

the Verify and Repair buttons are 
dimmed in the Disk Utility window, 
make sure you have selected a 
volume to check.

When to use fsck instead
Starting with a Safe Boot or 

using Disk Utility while started 
up from CD or DVD eliminates 
the need to use fsck, but there are 
situations in which fsck may be 
necessary.
•	 Your Mac OS X disc is not 

immediately available. 
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•	 Your CD-ROM drive is not 
immediately available. 

•	 You can’t start with a Safe Boot.
The fsck utility may be able to 

verify and repair a disk in such a 
situation. 

Tip: If you use a Mac OS X 
Extended (Journaled) formatted 
volume, such as with Mac OS X 
Panther, you will probably not 
need to use fsck. If you do use it for 
some reason, be aware that benign 
error messages can appear. Tip: If 
you’re not sure how your volume is 
formatted, and you can’t start from 
your Mac OS X volume to check, 
type: “diskutil info /”. If you see 

“File System: Journaled HFS+”, then 
it’s a Journaled volume.

How to use fsck
The fsck utility is run from the 

command line. This means that 
you must type a text command 
at a prompt (#), rather than using 
the mouse pointer to open an 
application. Examples include the 
Terminal application and single-
user mode. Start in single-user 
mode to reach the command line.

Note: If necessary, perform 
a forced restart as described in 
the Emergency Troubleshooting 
Handbook that came with your 
computer. On desktop computers, 
this is generally achieved by 
pressing the reset/interrupt button, 
which is marked with a triangle. 
On portable computers, this is 
generally achieved by pressing the 
Command/Control/power keys. 
If a portable computer does not 
respond to this method, you may 
need to reset the Power Manager.

You may use a key combination 
when starting up the computer to 
enter single-user mode or verbose 
mode, either of which can be used 
for troubleshooting and in software 
development. This document 

applies to Mac OS X and Mac OS X 
Server versions 10.0 and later.
	 1.	Shut down computer if it is on. 
	 2.	Press the power button to start 

the computer. 
	3 .	Immediately press and hold the 

Command (Apple) key and one 
of the following:
•	 “s” key for single-user mode
•	 “v” key for verbose mode

	 4.	To exit single-user mode type: 
reboot

	 5.	Press Return. 
You have successfully entered 

single-user or verbose mode when 
you see white text appear on the 
screen.
	 1.	If you do not develop software, 

verbose and single-user 
modes are only needed when 
troubleshooting the computer 
for a startup issue.

	 2.	You cannot enter single user or 
verbose mode if the computer 
owner or administrator has 
enabled Open Firmware 
Password Protection.

	3 .	When in single-user or verbose 
mode, the keyboard layout is 
US English.

	 4.	At the command-line prompt, 
type: /sbin/fsck -fy

	 5.	Press Return.
The fsck utility will go 

through five “phases” then return 
information about the disk’s 
utilization and fragmentation. Once 
the check is finished, if no issue 
is found, you should see “** The 
volume (name of volume) appears to 
be OK.”

If fsck alters, repairs, or fixes 
anything, it will display the 
message:

“**FILE SYSTEM WAS 
MODIFIED” 
Important: If this message appears, 
repeat the fsck command until 
it no longer appears. It’s OK if 

you need to do several “passes” of 
fsck, because first-pass repairs may 
uncover additional issues.
	 6.	When fsck reports that, “The 

volume (name of volume) 
appears to be OK.”, type: 
reboot

	 7.	Press Return.
The computer should start up 

normally and allow you to log in.
The -y flag
This tells fsck that you want to 

answer “yes” to all questions about 
fixing, repairing, or salvaging 
information. This is the optimal 
approach, as answering “no” to any 
question causes fsck to stop. You 
cannot determine that all necessary 
repairs have been made until fsck 
completes and gives its final report.

The -f flag
Forces fsck to check “clean” file 

systems when preening.
Apple Barrel, Ridgecrest, CA

Compressing Files (.zip)  
in One Click

One of my favorite Panther 
features is the ability to create .zip 
compressed files from within the 
OS (basically, this shrinks the file 
size, ideal for files you are going to 
email—smaller file sizes mean faster 
file transfers). 

To create a compressed file, 
either Control/click on the file, 
then choose “Create Archive” 
(which is Apple-speak for “Make a 
compressed .zip file”), or you can 
click on a file, then go to the Action 
menu (the button that looks like 
a gear up in the Finder window’s 
toolbar), and choose “Create 
Archive” from there. Either way, 
it quickly creates a new file, with 
the file extension “.zip.” This is the 
compressed file. 

You can also compress several 
different files (like 3 for example) 
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into one single archive file—just 
Command/click on all the files you 
want included, then choose “Create 
Archive of 3 Items” from the Action 
menu. A file will be created named 

“Archive.zip” (that’s it!). 
By the way, if someone sends 

you a .zip file, don’t sweat it—just 
double-click it and Panther will 
automatically decompress it.

TMUG Insider, Pleasanton, CA

Dock Volumes
Q: Can I put a link to all of my 

volumes in the Dock? 
A: You could simply drag your 

drive and network volume icons into 
the Dock, which works just fine. Or 
you could take a craftier approach: 
drag the invisible Volumes folder 
into the Dock for access to all of 
your volumes in one folder. Do this 
by selecting “Go To Folder” from 
the Go menu in the Finder. Type 

“/Volumes” and click “Go” to open 
the invisible Volumes directory. 

From the top of the Finder 
window, drag the little folder icon 
for the Volumes folder into the 
Dock. You won’t be able to access 
most removable drives via the 
Docked Volumes folder, but it’s 
still handy.

MacAddict Magazine

Gain Access with your Mac OS X 
Admin Password

It is important to remember 
that anyone with an administrative 
password can access any of the 
files on that computer (unless, of 
course, the files are encrypted). 
Normally, the administrator has 
to log into the root level or use 
the Terminal application to review 
the files in another user’s directory, 
but if a computer is set to lock 
the screen when the screensaver is 
activated, the administrator can 

simply press any key and then enter 
his username and password in the 
unlocking dialog box. When he 
does so, the screen unlocks to the 
account that was open before the 
computer was put to sleep.

TMUG Insider, Pleasanton, CA

Panther Keyboard Shortcuts
Most keyboard shortcuts 

are consistent from program to 
program on the Mac, but there 
are exceptions. The “Hide All 
Windows” command in Photoshop, 
for example, should be Command/
H like most other Mac programs, 
not Option/Command/H. But 
using the new Panther Keyboard 
control panel, you can easily 
change any keystroke in any 
program. You can also make up a 
new keyboard shortcut for menu 
commands that doesn’t have them. 
You will love this!

Mouse Droppings, Corvallis OR

Deleting Passwords
Q: I am running OS 10.3 and 

have saved a number of passwords 
when asked by the operating system. 
There are some that I would now 
like to delete. I remember doing 
this some time ago, where I was 
able to bring up a list of passwords. 
I believe it had to be done through 
the Administrator. I cannot now 
remember how to do it! Can you 
help me in this matter?  
~Paul Thomas

A: You’ll need to open Keychain 
Access, which you can find at 
Macintosh HD > Utilities > 
Keychain Access. Once you’ve 
opened it up, you’ll see a list of 
password items that have been 
saved. If necessary, click the Lock 
to unlock your keychain. You’ll be 
asked to put in your administrator 
password. Once the keychain is 

unlocked, you can simply select an 
item and choose Edit > Delete.

macHOME HotTips

Registration Codes  
for Your Applications

When you get new software, one 
of the most important items is the 
registration code. Whether you 
register online or receive the code 
in the software package, it is crucial 
you keep track of that all-important 
number! Many install CDs or 
floppies come with the number 
printed on the label, or stickered on 
the CD case. Those are simple ... as 
long as you have the software, you 
have the registration code. However, 
if your CD case gets cracked, or 
you replace the paper or plastic 
sleeve with a real jewel case, be 
sure to remember to transfer that 
code! Taking a moment to make a 
tiny sticker or tape a snipped-out 
code number to the case can save 
you hours (or days!) of grief if you 
ever have to reinstall the software. 
~Virginia Chilcote

MouseBytes, St. Petersburg, FL

Internet

Google: Are You Using It  
To Its Fullest?

A search engine is a program that 
searches for specified keywords and 
returns a list of the documents or 
web sites where the keywords were 
found. Alta Vista, Google, and 
Ask Jeeves are examples of search 
engines that look for documents 
and/or subjects on the Internet. 
Some definitions of Google refer 
to it as a verb, such as “Google 
it, now.” Time-after-time Google 
shows up as one of the best. But are 
you using it to its fullest? There are 
so many ways to search on Google. 
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Did you know that if you type “one 
decade in seconds” (without the 
quotes) that you will get the answer 
(315,569,260).

Calculator
To use Google’s built-in 

calculator function, simply enter 
the calculation you’d like done into 
the search box and hit the “Enter” 
key or click on the Google “Search” 
button. The calculator can solve 
math problems involving basic 
arithmetic, more complicated math, 
units of measure and conversions, 
and physical constants. To learn 
how to use the calculator, go to 
http://www.google.com/help/
calculator.html.

Google Made Easy
Go to http://www.google.com/

options/index.html and use the 
categorized icons.

Doodles
If you want to see some of 

the first Google logos or doodles 
go to http://www.google.com/
holidaylogos99.html. Dennis 
Hwang is the fellow that draws 
the doodles and has produced 
almost 150 of them. He actually is 
Google’s international webmaster. If 
you want to suggest a theme for a 
Google doodle, send him a note at 
doodle@google.com

Games on Google
Just type in “Google Games” 

in the search engine and you’ll 
find that many people have 
created games to be played with 
Google. I discovered one called 
Googlewhacking. It was mentioned 
on the NBC Today show a couple 
of weeks ago. It’s played this way: 
you think of two words and type 
them in the search box. The idea is 
to get the resulting web sites down 
to ONE. Yes, one! This is more 
difficult than it sounds. It took me a 
while to do it but I got it. 

Finding NONE doesn’t count. 
Got to get it down to ONE. Let me 
know if you get it and what words 
you used. I will tell you though 
that Cruciate olives got 65 results. 
Now, that’s a pretty low count. And 
wireless pizza got 1,320,000 results. 
Go figure!

Compare Search Engines
You might want to try another 

search engine such as Yahoo or 
Alta Vista or Teoma. Check out the 
Noodletools site to compare search 
engines and you decide which one 
is best for you. I think you’ll agree 
that Google is the best. http://www.
noodletools.com/debbie/literacies/
information/. ~Virginia Chilcote

MouseBytes, St. Petersburg, FL  
via TMUG Insider, Pleasanton, CA

Change Your Default Web 
Browser

Your Mac launches a Web 
browser when you click on a link 
to a Web page in an email message, 
text file, etc. You can control 
which Web browser is launched by 
doing this: In Mac OS 9, go to the 
Internet control panel and select 
the Web tab. At the bottom of the 
Web pane, select your preferred 
Web browser from the Default Web 
Browser pop-up menu. In Mac OS 
X, launch Safari and choose Safari 
> Preferences. In the General tab, 
choose a Web browser from the 
pop-up menu next to Default Web 
Browser. After that, any time your 
Mac automatically launches a Web 
browser, it will be that one.

Design Tools Monthly

Paparazzi and SiteSucker
Courtney Wright mentioned 

a program called “Paparazzi,” for 
saving the content of a web page. If 
you have a web page displayed, and 
want to save a copy of it, then you 

can start Paparazzi, then enter the 
URL of the web page (drag and 
drop from the Browser will do it). 
Then Paparazzi can access the web 
page itself, and save to a PNG file, 
which Preview can read. 

You may want to rename the file, 
since Paparazzi just sticks png on 
the end of the URL. This program 
may be contrasted with SiteSucker 
(current OS X version is 1.6.3), 
which, given a URL, downloads the 
web page together with other pages 
linked to it, down to a specified 
depth. This is important, for 
example, if you want the pictures, as 
well as what is in the source html file. 

But it can fall down if the web 
page has complicated links to other 
web pages, or (even worse) links 
that refer back to a page you have 
already downloaded. ~Bruce Craven
AUSOM News, Melbourne, Australia

Check Your Credit Report  
for Free

Recent U.S. legislation requires 
the three major credit reporting 
companies—Equifax, Experian, 
and TransUnion—to provide 
anyone who asked with a free credit 
report once every 12 months (so 
you can get one credit report from 
each company all at once, or you 
can request a report from one of the 
companies every four months to be 
on the lookout for problems). 
www.annualcreditreport.com/
www.epic.org/privacy/fcra/
www.epic.org/privacy/preemption/

The Finder, Mid-Columbia MUG, 
Kennewick, WA

A Shortcut for Accurately 
Selecting Text on a Web Page

If you’ve tried to highlight text 
on a Web page by dragging your 
mouse across the text with the 
button depressed, you know how 
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awkward it can be. Often either 
some of the text you meant to select 
is left out, or else headings, figures, 
and other elements are mistakenly 
included in your selection. 
Fortunately, there’s a much cleaner 
and easier way. Simply click just 
to the left of the beginning of the 
text you want to select, release 
the mouse button, position your 
insertion point immediately 
following the last part of the desired 
text, hold down the Shift key and 
click again. When you do, all the 
text between the two click points is 
highlighted and selected.

TMUG Insider, Pleasanton CA

Thinking in Reverse
MacValley member Norah 

Graham writes: “I often use www.
dictionary.com as it has multiple 
dictionaries and a thesaurus, but 
I have recently found a nifty 
alternative. 

It is one thing to know the word, 
but how often have you known a 
concept but could not think of a 
word to describe it? For that you 
need a reverse dictionary, and I 
found one at http://www.onelook.
com/reverse-dictionary.shtml. You 
type in a description and it pops out 
the words. 

You can also search for delimited 
strings so, if you know how the 
word is partially spelled or you are 
looking for crossword answers, you 
can find them.

MacValley Voice, Northridge, CA

MS Entourage

Correcting Capitalization
Do you have Entourage insisting 

on capitalizing the first word after 
each period? Does Entourage always 
wants to AutoCorrect the first letter 

of a sentence to a capital letter, even 
after an abbreviation, like “Add 50 
ml. Of solution”?

To fix this problem you need to 
turn off the Auto Correct command. 
Many people miss this ability 
to turn it off because instead of 
looking in Entourage’s Tool’s menu, 
they look in the preferences. 

In the Tools menu find the 
AutoCorrect command. Select it 
and in the resulting window you’ll 
see the “Capitalize first letter of 
sentences” option. Disable this 
option and Entourage will no 
longer do the capitalization thing 
after an abbreviation. 

You can also leave this option on 
but click the Exceptions button and 
add any abbreviations you like in 
the “Don’t Capitalize After” field.
Apple Pickers MUG, Indianapolis, IN

Email

Junk Mail Caution
Junk mail (or “spam”) is 

becoming a bigger nuisance every 
day, and you may be tempted to 
take drastic action to curb the flow. 
It is possible that your ISP allows 
you to set the sensitivity of spam 
filters that he applies, or you may 
be able to make a similar choice in 
your email program. 

The purpose of this item is simply 
to warn you against becoming too 
aggressive in this regard. The simple 
reason is that the less tolerant your 
spam filter is, the more likely it is 
that wanted mail will be discarded 
without your ever seeing it. 

Junk filters work by looking in 
each message for data that is known 
to be typical of junk mail. Words 
and phrases, source addresses, 
routing, and more are examined 
and a “score” given for each suspect 

item found. Messages with an 
aggregate score above a defined level 
are rated junk and are filtered out. 

If your email program does 
the filtering, you do at least have 
a chance to review the suspect 
messages to see if any are wanted, 
but if your ISP does the filtering, 
you will never see the filtered 
messages at all. 

A very common situation in 
which wanted mail may be filtered 
out occurs if you order something 
online, or send any other kind 
of message which results in an 
automatically-generated response. 
Such responses commonly contain 
data typical of junk mail even 
though they are not, and unless you 
are alert to the possibility, you may 
never see the response. 

Even if a message is otherwise 
quite innocent, it may be filtered 
because of the presence of some 

“suspect” term or phrase. 
I recently read of a woodworking 

hobbyist who almost lost many 
messages from friendly folks not in 
his existing address book because 
they contained more than two 
instances of the word “inches.” 

There are a few things you can 
do to reduce the possibility of losing 
wanted mail:
•	 If you receive a message from 

someone “friendly” but 
previously unknown to you, add 
that person to your address book 
straight away. That should ensure 
that future messages from that 
person will get through to you.

•	 Don’t ask your ISP to implement 
very aggressive junk mail filters. 
Use your email program’s filters 
instead. That way, you will at 
least have the opportunity to 
review mail that has been rated 
as junk.

•	 If your email program’s junk 
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filters can be “trained,” as Apple 
Mail’s can, pay attention to 
doing so. The more you train, 
the more accurate the filtering 
function will become. (Note 
that you should continue to train 
Apple Mail even after switching 
it to “automatic” filtering mode. 
For more information on Mail’s 
junk filter, open its Help menu 
and enter “filtering junk mail” as 
the search text.)

•	 Do check your filtered junk mail 
before finally dispatching it to 
the trash. Just scanning the 
subject lines is usually sufficient 
to sort the wheat from the chaff. 
If you do need to check the text 
to be sure, remember that Apple 
Mail will not display any images 
in a message rated “junk” unless 
you ask it to. That knowledge 
may make your task a little less 
challenging.

•	 When writing to friends, don’t 
use subject lines like “Hi there,” 

“Hello” or “A surprise for you.” 
Instead, try to include some 
meaningful words. Otherwise, 
they may just trash your message 
without reading it. 

~Steve Cooper
AUSOM News, Melbourne, Australia

Auto-Opening Hyperlinks
Q: I’ve used Macs for years, but 

for some reason I don’t know how 
to include a usable link in an email 
message so it automatically opens 
the webpage. Any help?  
~Linda Phillips

A: There’s no trick to adding a 
hyperlink to your email messages; 
you just type it in and click send. 
It is a user’s email application that 
determines how those hyperlinks 
are handled. 

Older email applications are a bit 
fussy with hyperlinks, so to be on 

the safe side, you should include the 
“http://” as part of the link. 

There is no way to tell a hyperlink 
to automatically open when the 
mail is received, however. And 
that’s a good thing. Consider for 
a moment the chaos this would 
cause. Not every emailer is as 
benevolent as yourself, and you can 
just imagine the sites that would 
be auto-triggered by spam. And it 
would surely be a crippling security 
issue on the PC platform, which 
continues to be plagued by viruses 
and spyware.

macHOME HotTips

GoLive

Finding Your Buddy List
Have you started using iChat yet? 

If you haven’t and you have friends 
or family who are frequently on 
their computers, it is a totally cool 
way to communicate. 

One of my children works in an 
environment where personal phone 
calls are not possible. She works 
on a computer all day and iChat is 
allowed, so we can carry on short 
conversations as needed. Another 
of my children has a very busy 
schedule. I can send him an iChat 
message (something to the effect 
of “hello son, remember me?”) and 
what do you know, I get a phone 
call. Works every time. 

Seriously, I can leave him a 
message no matter what time of day 
it is and he will either immediately 
come back for a conversation or get 
back with me later. 

My iChat tip is this: I discovered 
that if I had a conversation going 
on with one person I couldn’t figure 
out how to get my Buddy List open 
to start a second conversation with 
someone else. I finally resorted to 

asking a friend from Apple and as it 
turns out the answer is quite simple. 
Hold down Command/1 (that is 
the number one) and it will pull the 
Buddy List up for you.

Mouse Tales, North Coast MUG, 
Berea, OH

Easier Table Selection
Ever find yourself working in 

a table cell and need to select its 
encompassing table, or even an 
outer table if you’re working in 
nested tables? Of course, you can 
use the mouse, but if you prefer the 
keyboard instead, try this:

Control/Return moves you 
outward one level in the nesting 
hierarchy. Need to move inward? 
Press Return to move down one 
level. ~Deborah Shadovitz

Mac Design Magazine

A Word About What
Q: Whenever I try to copy a bit 

of text from Microsoft Word into 
iChat, an attachment appears in the 
iChat window instead of the text. 
What’s going on? ~Bill Dunn

A: Word text is formatted in 
such a way that iChat thinks it is a 
graphics file instead of text. When 
you send one of these attachments, 
recipients see a black bar rather than 
words. The secret to resolving the 
issue is to strip out that formatting 
before you bring the copied text 
into iChat.

Although you can do this by 
pasting the text into a text editor, 
copying it again, and pasting it into 
iChat, who needs the aggravation? 
I prefer Carsten Blum’s free Plain 
Clip, an application that strips 
formatting from text stored in 
the Clipboard, combined with 
Jean-Daniel Dupas’s free Spark 
2.0, which lets you create hot keys 
for launching applications and 
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documents, executing AppleScripts, 
and controlling iTunes. I’ve used 
Spark to create a key combination 
that invokes Plain Clip, so when 
I want to copy text from Word 
into iChat, I copy the text, press 
Command/Shift/C (the hot key I 
created to launch Plain Clip), and 
paste the text into iChat.

Chris Breen’s Mac 911  
via TMUG Insider, Pleasanton CA

Photoshop

Find Out What’s New in CS2
What better way to see what’s 

new with Photoshop CS2 than by 
using one of CS2’s new features 
to find out. Just choose Window > 
Workspace > What’s New in CS2. 
Then go through each menu item. 
Photoshop will show each new 
feature highlighted in the menus. 
To get back to normal view, just 
choose Window > Workspace > 
Default Workspace.

Layers Magazine

Faking a Split Neutral Density 
Filter with Photoshop and 
Camera Raw

Have you ever come across an 
exciting scene with a dynamic, 
powerful sky, but the results after 
capture have been disappointing? 
Maybe that stunning sky was 
washed out, or the foreground was 
plugged up. That’s because the 
light was stronger in the sky, and 
the exposure required was different 
than that needed for the foreground. 
Because of the limited dynamic 
range that can be captured on a 
camera, photographers may use a 
split neutral density filter. This filter 
allows us to expose for a brighter 
sky by filtering it down.

What if you don’t have a filter? 

You could use a tripod and shoot 
several images at different exposures 
and mix them together. However, if 
you’ve shot in the RAW format, you 
can also fake it in Photoshop and 
still get a very good result. 

Here’s how:
	 1.	Open your RAW image in 

Photoshop Camera Raw.
	 2.	Make the adjustments for the 

best exposure in the foreground. 
Don’t worry about blowing out 
the sky at this point.

	3 .	Click “OK” and save the 
image as a .tif or .psd. This will 
release the RAW file, allowing 
you to open the image in 
Camera Raw again.

	 4.	Open the original RAW image 
in Camera RAW again.

	 5.	This time make the 
adjustments for optimum 
exposure in the sky. You now 
have two images open. The 
following steps are the same 
that you would use for a 
multiple-exposure image.

	 6.	Choose the Move tool; click-
and-drag the darker image into 
the lighter image document as 
you hold down the Shift key to 
center the image.

	 7.	Click the “Add a Layer Mask” 
button (second to left at the 
bottom of the Layers palette).

	 8.	Press the “D” key to reset the 
foreground and background 
colors.

	 9.	Choose the Gradient tool; 
set the options for linear, 
foreground to background. The 
gradient will create a smooth 
blend between the top and 
bottom layers by using the layer 
mask. White shows the layer 
contents, while Black hides 
the layer and reveals the layer 
beneath.

	10.	Drag the gradient tool 

vertically. The transition 
will happen in the dragged 
area. Make a short drag for 
an abrupt transition between 
layers. Make a longer area for a 
smoother, softer transition.

This is an easy technique that can 
add a lot of impact to your images 
without too much effort. 

Check out my training videos at 
www.photoshopCD.com for other 
useful techniques. ~Colin Smith

Studio Photography  
& Design Magazine

iPhoto

Flummoxed by iPhoto
If your iPhoto 5 rendered 

slideshows are too bulky, you 
may be choosing the “wrong” 
slideshow. http://www.macworld.
com/weblogs/mac911/2005/04/
iphotoflum/index.php

The MUG Center  
www.mugcenter.com 

via TMUG Insider, Pleasanton, CA

Trimmer iPhoto Library
Q: Is there any way to make 

Apple’s iPhoto save changes to an 
original photo, short of moving 
the altered photo completely out 
of the program and importing 
it again? For example, when I 
reduce red-eye, I end up with the 
original photo and the altered one. 
Sometimes this is a waste of hard 
drive space. ~Eric Anderson

A: I agree that this feature 
is both a blessing and a curse. 
Granted, you can always gain 
access to your unaltered original: 
just select the edited picture 
and choose Photos > Revert To 
Original. But iPhoto makes the 
magic happen by squirreling away 
two copies of the photo—the 
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original and the edited version.
To free up hard-disk space, 

consider Martin Fuhrer’s free 
iPhoto Diet (http://pages.cpsc.
ucalgary.ca/~fuhrer/personal/
freestuff/iphotodiet/). This utility 
slenderizes your photo library 
by eliminating duplicate photos, 
removing backups of rotated or 
modified photos, stripping out 
your photos’ thumbnail icons, and 
locating and disposing of photos 
never added to an album.

Chris Breen’s Mac 911  
via Mouse Droppings, Corvallis, OR

Suffering From iPhoto Overload
Digital photography is a 

wonderful technology. It enables us 
to improve our photographic skills 
through experimentation with 
different settings, compositions, 
and exposures; the list of alternates 
goes on. Without the expense of 
film and developing, many of us 
are taking more pictures than 
ever. Add to that the flexibility to 
edit images using Photoshop or 
Photoshop Elements and a need 
arises to save original images as 
well as the edited versions.

All this flexibility can result in 
so many pictures in your iPhoto 
library that you one can’t locate the 
one of Aunt Suzie you want to send 
to your grandchildren.

There are ways to successfully 
catalog images in iPhoto if you 
limit the number of photos you 
place in iPhoto. That doesn’t 
address the issue of how to keep 
original images for future use and 
edited ones to enjoy now. 

If you are like me and many 
other photographers, you are 
taking and editing more photos 
than you actually need to keep for 
ready-access through iPhoto. 

For those of us seeking an 

alternative, Apple provides a way 
called “Image Capture”. It can be 
found in your “Applications” folder. 
Here’s one way to use it for better 
image management.

1. First, after opening the 
application, go to “Preferences > 
General” and, in the pull down 
menu in the camera section, select 

“Image Capture.”
The next time you connect a 

camera or other memory device 
you will see asking where to 
download your images, do an 

“Automated Task,” an Options 
button, and the “Download Some” 
and “Download All” buttons.

From the pull-down menu 
next to “Download To: select a 
folder or create one of your own. 
This will store your images in 
an intermediate folder instead 
of iPhoto. I’ve used names like 

“camera images”, “holding folder,” 
etc. The purpose is to capture 
your camera’s data in a known 
place. Except for those with more 
expensive cameras, the files will be 
in .JPG format.

2. After the downloading is 
complete, go to this folder and 
begin changing the names of the 
images. For example, change an 
image with a name like DCP12345.
jpg to a name and date code 
like: Auntsuzie050328.jpg. This 
indicates it is a photo of Aunt 
Suzie taken on 2005 (05) March 
(03) the 28” (28). How you code 
your images is your decision; do 
what you feel comfortable doing. I 
strongly recommend a date code 
element to help you know which 
photo of Aunt Suzie you are 
working on.

3. If you are a serious 
photographer (e.g. you paid more 
than $200 for your camera and 
it has settings), you should save a 

copy of the original camera data 
file (jpg for us cheapies or tiff or 
RAW for the pro’s) in your photo 
archive folder. If I was a serious 
photographer, I might keep these 
files in an iPhoto Library ONLY 
if it was a library that I NEVER 
modified. Personally I think a 
separate iPhoto Library devoted to 
ONLY original camera images is a 
sensible approach, but professionals 
might worry about degradation 
during the import to the iPhoto 
Library and prefer to have a 
separate folder in their Pictures 
folder to store original data.

4. You now have a set of 
images that you have renamed 
and MAY have stored a copy of 
in your Archive folder/system. 
These images are in your “holding” 
folder; they most likely have a .jpg 
extension. Use your version of 
Photoshop, Photoshop Elements (2 
or 3 or later) to open each image. 

Do NOT do any editing of the 
original image. Then do a “Save As” 
on each image where you choose 
Photoshop (creates a psd extension) 
as the file format and save to an 

“import” folder. 
With the exception of a special 

event (wedding, etc.), you may 
want to collect images on a 
calendar basis. I personally save 
these images to a folder named 
by each yearly quarter. The name 
of this “import” folder becomes 
the name of the Film Roll when 
imported into iPhoto; choose a 
name for the import folder that 
makes sense when you view the 
film roll in iPhoto.

5. Finally, open iPhoto Library 
Manager or iPhoto to get to the 
library that will hold your images. 
Import the set of images from the 

“Import” folder to iPhoto. Once 
in, you can clear out the images in 
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the “import” folder OR delete the 
“import” folder if you have given it 
a unique name.

Separate from the file/image 
management issue, you should 
be aware that iPhoto keeps two 
copies of your images. Your original 
imported image is retained. Any 
modifications create a NEW image 
with the same name. 

You always have the ability to 
“Revert to Original;” this throws 
away any changes and brings you 
back to the imported file.  
~Jerry King

MacFriends Report, Naples, FL

Pictures Going Out
Q: Is there a way that I can email 

photos from iPhoto without having 
the actual picture in the message of 
the email? I would like it to be sent 
as an attachment, instead of the 
way it is sent now, as an attachment 
that is visible in the message section. 
~Riki Fritz

A: You’re to be commended for 
your sensitivity in sending large 
files. It is actually the mail reader 
that determines whether or not the 
images appear in the body of the 
message. 

There is a way you can get around 
it, though. First, go to the Finder, 
click the Desktop, and choose File > 
New Folder. Give it a name. 

Now open iPhoto and select the 
pictures you want to send. Choose 
Share > Export, set the picture size 
and then click “Export.” Save the 
images to the folder you just created 
on your desktop. 

Now open your mail application. 
Create a new message, and then add 
the folder to it as an attachment. 
It’ll be compressed and encoded and 
sent out strictly as an attachment.

macHOME HotTips

iMovie

iMovie Click Tricks
Q: How do I change the position 

of titles in Apple’s iMovie? Except 
for the subtitle effect, which appears 
along the bottom of the screen, 
titles are in the middle of the frame.

A: You can change where some 
titles appear by clicking on the 
title in the Preview window and 
dragging it to a new location—from 
the middle of the window to the 
bottom, for example. To find out 
which titles support this feature, 
move your cursor into the Preview 
window after you’ve selected 
iMovie’s Title tab. If the cursor 
changes to a cross hair, you can 
modify the title’s location.

This trick also works with 
iMovie’s “Scale Down” transition 
and a few effects. Select “Scale 
Down,” and then click anywhere in 
the Preview window and the effect 
will scale down to that point. Click 
in the “Preview” window to change 
where the Electricity, Fairy Dust, 
and Lens Flare effects occur.

Chris Breen’s Mac 911  
via TMUG Insider, Pleasanton, CA

Convert VOB Files for iMovie
In the April 2004 issue, you 

suggested using OpenShiiva to 
convert VOB files to a format 
readable by iMovie. If you own a 
copy of Roxio’s Toast Titanium 
($80; www.roxio.com), you can 
convert files easily. Open Toast 
and click on the “Video” tab. Drag 
and drop your VOB files into the 
Toast window, as though you were 
creating a disc. Within Toast, select 
the video file to convert, and then 
select “Export Video” from the Disc 
menu. You’ll be prompted to save 
the converted file as a .dv file, which 
can be read by iMovie. There are 

some limitations depending on the 
audio format (for instance, Dolby 
Digital AC-3 requires Toast with 
Jam), but they shouldn’t apply to 
your DVD source discs. When 
you’re done converting, you can quit 
Toast without saving the project. 
~Martin Dellwo

Chris Breen’s Mac 911  
via Apple Barrel, Ridgecrest CA

iWork

17 Things You Might Not Know 
You Could Do with iWork

If you’ve installed iWork on your 
hard drive but haven’t had a chance 
to really dig into it yet, maybe 
this article will inspire you to do 
so. Giles Turnbull takes you on a 
romp through this production suite 
showing you lots of fun and useful 
things to do with it.
www.macdevcenter.com/pub/a/
mac/2005/04/12/iwork.html

The MUG Center  
www.mugcenter.com 

via TMUG Insider, Pleasanton, CA

Laptops

Buy PowerBook Now or Later?
Q: I still use the PowerBook G4 

(Titanium) and it is time for me to 
upgrade. I was going to purchase 
the new PowerBook G4 that was 
announced a few weeks ago, but 
I have this really horrible feeling 
deep down inside that the second 
I hand over my credit card for the 
purchase, Steve Jobs will unveil the 
new PowerBook G5s. Of course, 
I’ll have just spent everything I 
can spend and won’t be able to 
afford to upgrade for at least two 
to three years. Now, some people 
are saying that the PowerBook G5s 
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are just around the corner and 
others are saying that it’s at least 18 
to 24 months away. I need a new 
computer but am willing to wait if 
the next generation models are not 
too far away. What would you do?  
~Jerry Smith

A: Your question hits very close 
to home. There has been very little 
news about the PowerBook G5 
except for Apple personnel saying 
that it will be a long time coming 
because of the challenges of putting 
the powerful (and excessively hot) 
processor into a PowerBook. The 
only other information we’ve 
heard comes from DigiTimes, 
a Taiwanese newspaper with a 
somewhat spotty record of accuracy. 
The newspaper recently reported 
that Quanta Computer has been 
awarded the contract to produce 
PowerBook G5s in Q2 2005. It 
could very well be a misprint or a 
misinterpretation. Apple’s second 
quarter runs from January 1, 2005 
to March 31, 2005, so it is possible 
that the article is referring to the 
recently announced revisions of the 
PowerBook G4.

Apple’s products typically have 
a lifespan of six months before 
they are updated. So we can 
assume that an announcement is 
at least four months off. Apple’s 
WWDC (Worldwide Developer’s 
Conference), being held June 6-10, 
is an ideal venue for unveiling a 
product as monumental (and as 
coveted) as the PowerBook G5. 
I must stress that this is just a 
supposition; I have absolutely no 
additional information to confirm 
this date. It could very well be 
another year or more before we see a 
PowerBook G5.

You’re obviously looking to make 
a long-term investment though, 
so here’s something to consider. 

Since you plan on holding on to 
your new PowerBook for at least 
two to three years, you have to ask 
yourself, what if the first generation 
of PowerBook G5s don’t quite have 
all the kinks worked out of them? 
Can you afford to make a long-term 
commitment to a new product with 
no track record? Is it more prudent 
to wait for the first revision to the 
PowerBook G5s after they’ve been 
road-tested by thousands of users? 
The answers to these questions 
may help you to decide whether 
or not you want to wait for the 
PowerBook G5.

Now, if you absolutely need 
a new computer in the next two 
months, you might consider buying 
the low-end iBook or even the Mac 
mini, both of which have faster 
processors than your TiBook, and 
selling it once Apple announces 
the PowerBook G5. Yes, you’ll lose 
some money in the sale, but at least 
you’ll have something to tide you 
over until the fabled beast finally 
steps out of the shadows.

macHOME HotTips

Apple Recalls Some  
PowerBook Batteries

In cooperation with the 
U.S. Consumer Product Safety 
Commission (CPSC) and other 
international safety authorities, 
Apple is voluntarily recalling certain 
lithium ion rechargeable batteries 
that were sold worldwide from 
January 2004 through August 2004 
for use with 15-inch PowerBook G4 
(Aluminum) notebook computers. 
These batteries were manufactured 
by LG Chem, Ltd. of South Korea. 

The affected batteries could 
overheat, posing a fire hazard. 
Apple received four reports of these 
batteries overheating. No injuries 
have been reported. 

Apple urges you to stop using 
your battery and to order a 
replacement battery immediately. 
If you continue to use your battery, 
do not leave it unattended, and 
check for signs of overheating. 
Apple has initiated an exchange 
program and will provide eligible 
customers with a new replacement 
battery, free of charge. No other 
PowerBook or iBook batteries are 
part of this recall.

Identifying your battery: 
The recalled batteries have the 

Model Number: A1045 and serial 
numbers that begin with: HQ404, 
HQ405, HQ406, HQ407, or 
HQ408. Batteries with the affected 
serial numbers contain cells that 
were manufactured by LG Chem, 
Ltd. of South Korea during the 
last week of December 2003 only. 
The model and serial numbers 
are located on the label on the 
bottom of the battery, and can be 
viewed by removing the battery 
from the computer. The serial 
number is printed in black lettering 
beneath a barcode. The battery is 
approximately 4.75-inches long 
by 3.25-inches wide by .75-inches 
high. Or, in metric measurements, 
the battery is approximately 12 cm 
long by 8 cm wide by 1.9 cm high. 
The label located on the bottom of 
the battery reads in part, 15-inch 
PowerBook G4 Rechargeable 
Battery and Model No: A1045. 

Note: If your battery serial 
number does not match the 
requirements listed above, you do 
not have to exchange your battery.
https://depot.info.apple.com/
batteryexchange/index.html

www.smalldog.com   
via Charlotte MacWorkshop,  

Charlotte NC
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If you are not a member of a Macintosh User Group, I highly recommend that you find one in your area and join. User groups are the greatest source 
of information and help available to all Mac users — from novices to experts. You can find one in your area by going to apple.com/usergroups/find.  


